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Subsection 1.1: System Background 

  
Introduction The Center for Devices and Radiological Health (CDRH) electronic 

Submission (CeSub) eSubmitter tool is a free program that allows program 
participants to electronically complete and submit information for a 510(K) 
device or radiation emitting product to the Office of In Vitro Diagnostic Device 
Evaluation (OIVD) or Radiological Health.  This tool is intended to automate 
the current paper submission process, allowing for quicker completion once 
users are accustomed to the software, as well as speed up the filing process with 
CDRH.  The eSubmitter software requires completing a series of questions in 
electronic forms and allows attaching documents when additional information 
is needed.  
 
Filing product reports for radiation emitting products is required by law.  The 
CeSub eSubmitter software replicates several of these reporting guides, which 
have been available in hard copy for decades.  If using the eSubmitter software 
is not desirable, you may continue to complete hard copies of the report, which 
are available as Adobe Portable Document Format (PDF) and/or Microsoft 
Word documents at www.fda.gov/cdrh/comp/eprc.html. 
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Subsection 1.2: About this Guide 

  
Introduction The instructions in this guide provide detailed information for installing the 

CeSub eSubmitter software into a computer with a Microsoft Windows 
operating system.  In addition, this user guide assumes familiarity with 
terms associated with using a computer (e.g. clicking and double-clicking).  
 
T his guide is organized into seven sections (including this one): 

• Section 1 provides an introduction and explains the requirements for 
running CeSub eSubmitter software, uninstall instructions, installation 
instructions, installation instructions for Microsoft Vista users, and proxy 
server instructions. 

• Section 2 provides instructions for starting the software, setting user 
preferences, and creating or reopening a submission. 

• Section 3 provides descriptive information about the eSubmitter 
software’s interface and toolbar. 

• Section 4 provides instructions for preparing a submission for completion, 
which includes entering information, saving submission entries or changes, 
and packaging submission files.  

• Section 5 provides information about the Output menu on the menu bar, 
which includes reports and forms. 

• Section 6 provides information regarding user support. 
• Section 7 provides a list of frequently asked questions and the 

corresponding answers.   
Please note that the screens used in this document are examples of what you 
might see while using the software.  However, they may not appear exactly as 
shown. 
 
Note:  The terms submission, report, and submission report are used 
interchangeably in this guide to refer to a submission report. 
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Subsection 1.3: Software Installation 

 
System 
Requirements 

• Windows Operating System 
• Adobe Acrobat Reader v5.0 or greater. 
• 30 MB of disk space 
• Access to a Compact Disk-Recordable drive (CD-R Drive) 
• Software capable of viewing HTML, such as a Web browser, 

Microsoft Word, or Adobe Acrobat (full install version, not the 
Reader) 

 
Uninstall 
Instructions 

Before installing CeSub eSubmitter, uninstall any other version of the 
software. 
 
Note:  If you do not have a previous version of eSubmitter or if you have 

eLaser Pilot Software, proceed to installing the current version of 
eSubmitter software. 

 
To uninstall a previous version of eSubmitter, follow the instructions below.  

 

Action Graphic 

1. Use Windows Explorer to navigate to the label for the 
computer’s installed hard drive, e.g., Local Disk (C:).  
For example, on a computer with Windows 2000: 

• Open Windows Explorer. 

• Double-click My Computer to display its 
contents. 

• Look for the label of the computer’s 
installed hard drive.  For example, (C:). 

 

2. Double-click on the label for the hard drive to display 
its contents. 

 

3. Navigate to and double-click to open the Program 
Files file folder. 

 

Continued on Next Page 
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Subsection 1.3: Software Installation 

 

4. Navigate to and click to open the eSub file folder. 
You will see the folder’s contents in the pane on the 
right-hand side of the screen. 

 

5. Double-click on the Uninstall.exe file, and follow the 
instructions provided. 

Note:  If you do not see the Uninstall.exe file: 

a. Locate and double-click to open the 
JExpress file folder. 

b. Double-click on the uninstall.bat file, 
and follow the instructions provided. 

 

6. When the previous version has been uninstalled, you 
are ready to install the current version of the CeSub 
eSubmitter software. See the following procedure. 

 

 
Uninstall 
Instructions 

Some users may be unable to uninstall CeSub eSubmitter by following the 
instructions above due to the restrictions and rights established on their 
system during the time of the initial install.  
 
To ensure the uninstall was successful, follow the instructions below.  

Continued on Next Page 
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Subsection 1.3: Software Installation 

 
 

Action Graphic 

1. Use Windows Explorer to navigate to the Control 
Panel. For example, on a computer with Windows 
2000: 

• Open Windows Explorer. 

• Double-click My Computer to display its 
contents. 

• Look for the label of the Control Panel. 

 

2. Double-click on the label for the Control Panel to 
display its contents. 

 

3. Navigate to and double-click to open the Add or 
Remove Programs location. 

4. Locate and click on the CeSub eSubmitter program 
icon. 

5. Click Change/Remove. 

6. Click Yes when the question window appears – “Are 
you sure you want to uninstall CeSub eSubmitter” 

 

7. Ensure the program is entirely removed by navigating 
to the program file and deleting it. Use Windows 
Explorer to navigate to the label for the computer’s 
installed hard drive, e.g., Local Disk (C:).  For 
example, on a computer with Windows 2000: 

• Open Windows Explorer. 

• Double-click My Computer to display its 
contents. 

• Look for the label of the computer’s 
installed hard drive.  For example, (C:). 

 

 

CeSub eSubmitter 
Release 4.3 User Guide  

6 



 

Subsection 1.3: Software Installation 

 

CeSub eSubmitter 
Release 4.3 User Guide  

7

Action Graphic 

8. Navigate to and double-click to open the Program 
Files file folder. 

 

9. Locate the eSub program file. 

 

 

10. Right click, and select Delete.  

 
 
Installation 
Instructions 

CeSub eSubmitter software can be loaded from the internet or from a CD-
ROM. The following two subsections will discuss instructions for each. 
 

 
Installation 
Instructions 
from Web Page 

CeSub eSubmitter software is available for downloading from the web at 
https://www.fda.gov/cdrh/cesub/.  To install the latest version of the CDRH 
CeSub eSubmitter software from this web page, follow the instructions 
below. 

 

Action Graphic 

1. Click the link for 
. 

 

Continued on Next Page 
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2. Follow the instructions provided. Following the 
instructions, the software will be installed locally on 
your hard drive in C:\Program Files\eSub. 

Notes:  1. You can change the location where the 
software is installed by changing the file 
path on the Installation Directory dialog 
box when it appears. 

 2. The software may be installed on a 
network.  CeSub eSubmitter has a file 
locking option that you set to prevent users 
from accidentally overwriting the work of 
another.  For details, see Networking on 
page 23. 

 

 
Installation 
Instructions for 
Microsoft Vista 
Users 

Compatibility issues have been identified regarding the use of eSubmitter 
with the Windows Vista operating system. These issues, related to the 
installation of the software under the “Program Files” directory, can prevent 
accessibility to data and output files generated by the software. These issues 
can be averted by relocating the eSubmitter Data and Output folders to a less 
restrictive directory (e.g., C:\Users\Public\eSub_Home). These settings can be 
changed by navigating to the File > Preferences option within the application. 
 
If you have already upgraded to the Windows Vista operating system or plan 
to in the future, see http://www.fda.gov/cdrh/cesub/vista.html on the FDA 
CDRH website for the latest information on successfully installing eSubmitter 
within Windows Vista.  

 
Installation 
Instructions 
from a CD-
ROM 

To install the latest version of the CDRH CeSub eSubmitter software from a 
CD-ROM: 
 

Continued on Next Page 
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Action Graphic 

1. Windows Explorer should be open on your 
computer’s desktop. 

 

2. Insert the eSubmitter CD-ROM in the CD drive of 
your computer. 

 

3. Navigate to the directory of the CD drive, if you do 
not see it on your screen.  For example, on a computer 
with Windows 2000: 

• Open Windows Explorer. 
• Double-click My Computer to display 

its contents. 
• Look for the label for the CD drive. For 

example, (E:). 

 

4. Double-click on the label for the CD drive to display 
its contents. 

 

5. Double-click on the jinstall.exe file.  

6. Follow the instructions provided. Following the 
instructions, the software will be installed locally on 
your hard drive in C:\Program Files\eSub. 

 

7. Note:  You can change the location where the 
software is installed by changing the file path 
on the Installation Directory dialog box when 
it appears. 

 

8. When the installation is complete, remove the CD-
ROM from the CD drive. 

 

9. Note:  The software may be installed on a network.  
CeSub eSubmitter has a file locking option 
that you set to prevent users from accidentally 
overwriting the work of another.  For details, 
see Networking on page 23. 
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Proxy Server 
Instructions  

If you are using a proxy server to connect to the Internet, then you will need 
to change the application's properties file (eSubmitter.properties) to 
reference the server. See your System Administrator for help in changing the 
properties file. 
 
The properties file is located in the application's JExpress subdirectory 
(Program Files\eSub\JExpress). Add the following switches before the -cp 
switch: -DproxySet=true -DproxyHost=[proxy_host] -
DproxyPort=[proxy_port] (replace [proxy_host] and [proxy_port] with the 
appropriate information for your configuration).  
 
If the proxy server requires a user id and password, add the following two 
properties to the update.control file that's also located in the JExpress 
subdirectory:  
 
proxyUserName= 
proxyPassword=  

 
 
 
 



 

Section 2: Getting Started   
Contents 

 
 This section contains the following topics: 
 

Topic See Page 
Starting the Software 12
Setting User Preferences 20
Creating a New Submission 28
Copy an Existing Submission to Create a New Submission 31
Re-open an Existing Submission 35

  

CeSub eSubmitter 
Release 4.3 User Guide  

11



 

Subsection 2.1: Starting the Software 

 
Introduction After you have successfully installed the CeSub eSubmitter software, you are 

ready to start up the application and create a new report.   

 
Starting the 
Software 

To start up the CeSub eSubmitter application, follow the instructions below.  

 

Action Graphic 

1. Start, and select Programs > CeSub eSubmitter > 
eSubmitter. 

 

2. You will see a Welcome dialog box, which provides 
an introduction to the application.   

You can set the Welcome dialog box to no longer 
display at application startup. For this setting, click to 
clear the Show this screen at Startup check box 
within the dialog box, as shown below. 

 

 
Welcome Dialog 
Box 

 
 

3. When you are finished reading the Welcome dialog 
box, click Close.  You will see an Alert dialog box (as 
shown below).  

Continued on Next Page 
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Subsection 2.1: Starting the Software 

 
Alert Dialog 
Box 

 
 

4. The Alert dialog box contains a special alert. Read 
the information carefully.  

If you have already upgraded to the Windows Vista 
Operating system or plan to in the future, follow the 
posted link 
(http://www.fda.gov/cdrh/cesub/vista.html) for 
instructions regarding successfully installing 
eSubmitter within Windows Vista.  

 

5. When you are finished reading the Alert dialog box, 
click Close.  You will see a Registration Dialog box 
(as shown below). 

 

Continued on Next Page 
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Subsection 2.1: Starting the Software 

 
Registration 
Dialog Box 

 
 

6. Click Next to continue the registration process. Or, 
click Register Later to register at another time.  If 
you click Next, you will see a Registration Dialog 
box asking you to enter your contact information. 

/ 

 
Registration 
Dialog Box: 
Contact 
Information 

 

Continued on Next Page 
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Subsection 2.1: Starting the Software 

 

7. On the Registration Dialog box, enter the information 
requested.  Required entries are indicated by blue 
dots.  Click Next. You see a Registration Dialog box 
asking you to enter address information. 

 
Registration 
Dialog Box: 
Address 
Information  

 
 

8. On the Address Information dialog box, enter the 
information requested. Click Next.  You see a 
Registration Dialog box to generate an email. 

 
Registration 
Dialog Box: 
Generate Email  

 

Continued on Next Page 
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Subsection 2.1: Starting the Software 

 

9. In the Generate Email step, you see a summary of the 
information you entered. If the information is correct, 
click Next.  If the information is not correct, click 
Previous until you return to the screen that you need 
to correct. 

/ 

10. Click Generate Email in the dialog box.  You will 
see an email. 

 

11. Click Send in the email.  You see a Registration 
Dialog box to check results.  

 

 
Registration 
Dialog Box: 
Check Results 

 
 

12. Select the button corresponding to either Yes the 
Email was sent correctly or No there was a 
problem. 

 

13. Click Done if the email was successful and to 
complete the registration process. 

14. If the eSubmitter software has been updated and you 
are connected to the Internet, you will see an 
Application Update Message to notify you that the 
software has changed (as shown below). 

 

Continued on Next Page 

16   CeSub eSubmitter 
Release 4.3 User Guide  



 

Subsection 2.1: Starting the Software 

 
Application 
Update Message 

 
 

15. On the Application Update Message: 

• Click No if you do not wish to see a list of the 
changes to the software.  You can review the 
changes at a later time if you wish.   

• Click Yes if you do want to review a list of 
changes to the software. You see the View 
Application History/Updates Dialog box (as 
shown below). 

 

 

 
View 
Application 
History/Updates 
Dialog Box 

 
 

16. Click Close when you are finished reviewing the list 
of changes. The dialog box closes. 

17. Next, you will see the Open Report Data Dialog box.  

Continued on Next Page 
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Subsection 2.1: Starting the Software 

 
Open Report 
Data Dialog Box 

 
 

18. This dialog box allows you to select an existing 
submission or begin a new one.  As you create new 
reports, they are shown in this dialog box as a list of 
all the available submissions with a comments area 
for viewing additional information on the selected 
submission.  However, if this is the first time that you 
started up the application after installing the software, 
the list will be blank. 

 

19. Look at the bottom of the Open Report Data Dialog 
box. You will see four option buttons that are 
described below: 

 

 

New Report 
Data 

Clicking this button displays the New Report Data Dialog 
box, which allows the creation of a new submission report 
file. The dialog box displays areas for the report type, as 
well as areas for entering a descriptive name for the 
submission, a file name, and comments. Any descriptive 
name may be assigned to a new submission report file, as 
long as it is unique to the submission list and not blank. It is 
a good idea to use a name that distinctly identifies the 
report. Use alphanumeric characters for file names. 

Continued on Next Page 
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Open Clicking this button closes the Open Report Data Dialog 
box, and opens the selected submission. In addition, 
double-clicking on a submission or pressing the Enter key 
while a submission is highlighted will also open the 
submission.  For complete information on creating or 
editing a submission, see Preparing a Submission, 
beginning on 44. 

Cancel Clicking this button closes the Open Report Data Dialog 
box with no changes to the screen. 

Help Clicking this button displays the help text for the Open 
Report Data Dialog box. 

 



 

Subsection 2.2: Setting User Preferences 

 
Introduction eSubmitter allows you to set preferences for the following four categories: 

 
• Auto Save 
• Layout 
• File Location 
• File Viewer 

 
Setting preferences prior to creating a submission will make the process much 
easier. To begin setting preferences, click on the File Menu > Preferences. The 
User Preferences Dialog box will appear (as shown below).  
 

 
 
The subsections below will explain how to set preferences for each category. 

Continued on Next Page 

CeSub eSubmitter 
Release 4.3 User Guide  

20 



 

Subsection 2.2: Setting User Preferences 

 
Auto Save • Auto Save – When this option is enabled, eSubmitter automatically 

saves your report while you work. You can also set the interval for how 
often you want to save your report. At default, auto-save is 
automatically turned on, and set to save files at 10 minute intervals. 

 
Note: The Blue Dot  indicates a required question. 
 

 
 

To change the auto-save option: 
 

Action Graphic 

1. Check or uncheck the box to select the enable auto-
save checkbox (to turn auto save on) or click to clear 
the checkbox (to turn auto-save off). 

 

2. If you cleared the checkbox, go to step 3. If you 
selected the checkbox, 

In the time interval box: 

Enter the interval (in minutes) for how often you want 
to save the file. 

OR 

Use the up and down arrows to select the interval. 

 

Continued on Next Page 
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Subsection 2.2: Setting User Preferences 

 

3. If you want to change or set the layout, click Next or 
the Layout tab.  See the description for Layout 
below. 

OR 

- If you are finished and satisfied with your changes, 
click OK to close the User Preferences Dialog box. 

OR 

- Click Cancel to close the User Preferences Dialog 
box without making any changes. 

 

 

 

 
Layout Allows you to set whether you want eSubmitter to open reports in the simple or 

expert layout when you start up the application. At default, eSubmitter opens 
reports in the simple layout. For more information, see descriptions in the 
Application Window section on page 37. 
 

 
 
To change the layout when eSubmitter starts up, follow the instructions below.  

 

Action Graphic 

1. In the initial layout box, select Simple or Expert 
from the drop-down menu.  

 

Continued on Next Page 
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Subsection 2.2: Setting User Preferences 

 

2. If you want to change the settings for networking, 
click Next or the Networking tab.  See the description 
for Networking below. 

- If you are finished and satisfied with your changes, 
click OK to close the User Preferences Dialog box. 

OR 

- Click Cancel to close the User Preferences Dialog 
box without making any changes. 

 

 

 
Networking Allows you to set file locking when using the software on a network.  The 

application is primarily designed for use by one user at a time.  However, in an 
effort to help support those that wish to run the application from a network and 
want to prevent users from accidentally over-writing the work of another, a 
simple file locking strategy has been incorporated.  By enabling file locking, a 
user will be warned if the file that they are attempting to open is currently in use 
by another.  At default, eSubmitter opens without file locking. 
 

 
 
To enable file locking, follow the instructions below.  

Continued on Next Page 
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Subsection 2.2: Setting User Preferences 

 

Action Graphic 

1. Click to select the Enable File Locking checkbox (to 
turn file locking on) or click to clear the checkbox (to 
turn file locking off). 

 

2. If you are finished and satisfied with your changes, 
click OK to close the User Preferences Dialog box. 

OR 

Click Cancel to close the User Preferences Dialog 
box without making any changes. 

 

 
File Location Allows you to change the location where your report data files are stored when 

saved and the location where files are generated when output (e.g., reports and 
packaged submissions). For more information on packaging files for submission, 
go to Package Files for Submission on page 85. 
 

 
 
To change the file location for the data folder and/or the output folder: 

 

Action Graphic 

1. Click the Select Location icon to the right of the text 
box.  

Continued on Next Page 
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Subsection 2.2: Setting User Preferences 

 

2. The Select File Location dialog box will appear. 
Click the Look In box, and navigate to the file folder 
where you would like your files stored.   

 

 
Select File 
Location Box 

 
 

3. Once you have navigated to the location, highlight the 
specific folder and click Select in the bottom right-
hand corner of the dialog box.  Your files will now be 
stored in the new specified location. 

Recommended Location: 
If installed on a Network drive (on Vista or 
Windows XP or earlier):  The location of your data and 
output files will be contained within the eSub directory 
where the application was installed. 
 
If installed on a Workstation (on Windows Vista): 
data and output files should be hosted in the following 
location: C:\Users\Public\eSub_Home\. 
 
If installed on a Workstation (on Windows XP or 
earlier):  data and output files should be hosted in the 
following location: C:\Documents and 
Settings\eSub_Home\. 
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Subsection 2.2: Setting User Preferences 

 
File Viewer Allows you to identify the application that you will use as your PDF viewer.  

(Generally, Adobe Acrobat is used as the application for viewing PDFs.) 
 

 
 
  Follow these instructions to set up your PDF viewer: 

 

Action Graphic 

1. Click the Select Location icon to the right of the text 
box. The Select Viewer Application File box is 
displayed (as shown below).  

 

 
Select Viewer 
Application File 
Box 

 

Continued on Next Page 
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Subsection 2.2: Setting User Preferences 

 

2. Click in the Look In box, and navigate to the file 
folder for Adobe Acrobat or the Acrobat Reader.  The 
location is usually either: 

• Program Files > Adobe > Acrobat > 
Acrobat.exe  

• Program Files > Adobe > Reader > 
AcroRd32.exe 

 

3. Click to highlight (select) Acrobat.exe or 
AcroRd.exe and click Select.  The File Viewer tab in 
the User Preferences Dialog box will now appear in 
the text box as shown below. 

 
User 
Preferences 
Dialog Box 

 
 

4. Click OK.  
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Subsection 2.3: Creating a New Submission 

 
Introduction This section provides an overview of creating a new submission report. 

Note:  Before proceeding, make sure you have already reviewed the 
Introduction, Getting Started, and Interface sections of this user 
manual. These sections provide valuable information that is necessary in 
order to follow and understand the instructions in this section. 

There are two methods for creating a new submission report:  starting from 
scratch with a completely blank report or copying an existing report and 
making the required changes. The purpose for copying an existing report would 
be to save time because many of the responses are the same. This might be the 
case if you have an existing report from the same model family or you are 
submitting a report supplement. The steps involved for both of these methods 
are provided below. 

 
Create a new 
Blank 
Submission 
Report from 
Scratch 

To create a new submission report from scratch: 
 

 

Action Graphic 

1. The CeSub eSubmitter application should be open on 
your computer desktop. If it is open, and you see the 
General Screen, go to step 2. (If it is not open, open 
the application first by following the instructions in 
Starting the Software on page 12.)  

 

2. Click File > New. (Or, click the New Report icon on 
the Tool Bar.) The New Report Data Dialog box is 
displayed. 

 

Continued on Next Page 
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Subsection 2.3: Creating a New Submission 

 
New Report 
Data Dialog 
Box 

 
 

3. Complete the fields on this dialog box as follows: 

• Report type – The entry is CeSub Report. Do 
not change this entry. (Required Entry, as 
indicated by the blue dot.) 

• Descriptive name – Enter any descriptive 
name, as long as it is unique to the submission 
list and not blank.  Use a name that distinctly 
identifies the report to you.  (Required Entry, 
as indicated by the blue dot.)   

• File name – Enter a valid name for the 
submission data. Use alphanumeric characters. 
(Required Entry, as indicated by the blue dot.)  
File names should not contain more than 
250 characters.  Do not use symbols when 
naming the files. For example, do not use 
slashes (/) (\), tildes (~), asterisks (*), periods 
(.), brackets [ ], single quotation marks (‘), 
double quotation marks (“) or parentheses ( ).     

• Provide additional comments… – Enter any 
additional information about this report 
(Optional Entry). 

 

Continued on Next Page 

CeSub eSubmitter 
Release 4.3 User Guide  

29



 

Subsection 2.3: Creating a New Submission 

 

4. When you are finished entering all information in the 
fields, click OK. The first screen of your new blank 
submission report is displayed. 

 
 

 
 

5. Click the drop-down menu, and select one of the 
following: In Vitro Diagnostic Device, Radiation 
Emitting Product, MedWatch Form 3500A, or 
Other. 

 

6. Click the Welcome (Cont.) node. 

NOTE: If you are in the simple layout, click the next 
arrow button.  

7. You are now ready to change the responses in this 
submission, go to Entering Submission Information 
on page 51. 
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Subsection 2.4: Copy an Existing Submission to Create a 
New Submission 

 
Copy an 
Existing 
Submission to 
Create a New 
Submission  

To copy an existing submission in order to create a new submission, follow the 
instructions below.  

 

Action Graphic 

1. Click File > Open. (Or, click the Open Report icon 
on the Tool Bar.) The Open Report Data Dialog box 
is displayed (as shown below).  

 

 
Open Report 
Data Dialog 
Box 

 
 

2. Click to select the existing submission report to be 
used as a template, and click Open. The submission 
report is displayed on your computer. 

3. Click File > Save As. The Save Submission As Dialog 
box is displayed (as shown below).  

 

Continued on Next Page 
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Subsection 2.4: Copy an Existing Submission to Create a 
New Submission 

 
Save 
Submission As 
Dialog Box 

 
 

4. Complete the fields on this dialog box as follows: 

• Report type – The entry is CeSub Report. 
Do not change this entry. (Required 
Entry, as indicated by the blue dot.) 

• Descriptive name – Enter any descriptive 
name, as long as it is unique to the 
submission list and not blank.  Use a name 
that distinctly identifies the report to you.  
(Required Entry, as indicated by the blue 
dot.) 

• File name – Enter a valid name for the 
submission data. Use alphanumeric 
characters.  (Required Entry, as indicated 
by the blue dot.) 

• Provide additional comments… – Enter 
any additional information about this 
report (Optional Entry). 

 

Continued on Next Page 
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Subsection 2.4: Copy an Existing Submission to Create a 
New Submission 

 

5. When you are finished entering all information in the 
fields, click OK. 

The first screen of your new submission report is 
displayed. 

 
Submission 
Report Main 
Screen 

 
 

6. Since you copied an existing submission, it already 
has many or all questions answered.  You now have 
the opportunity to go through and change responses 
for this new submission. (Creating a new submission 
in this manner is convenient if you are creating a 
supplemental report or creating a report for a product 
in an existing product family.) On this screen: 

• Click the drop-down menu, and select one of 
the following: In Vitro Diagnostic Device, 
Radiation Emitting Product, MedWatch 
Form 3500A, or Other. 

 

Continued on Next Page 
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Subsection 2.4: Copy an Existing Submission to Create a 
New Submission 

 

7. Click the Welcome (Cont.) node. 

NOTE: If you are in the simple layout, click the next 
arrow. 

8. You are now ready to change the responses in this 
submission, go to Entering Submission Information 
on page 51.  
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Subsection 2.5: Re-open an Existing Submission 

 
Re-open an 
Existing 
Submission 

To re-open an existing submission, follow the instructions below. 

 

Action Graphic 

1. Click File > Open on the menu bar. 

OR 

Click   on the tool bar. 

The Open Report Data Dialog box is displayed (as 
shown below). 

 

 
Open Report 
Data Dialog 
Box 

 
 

2. Click to select (highlight) the submission that you 
wish to open, and click Open. The selected report is 
displayed. 
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Section 3: Interface 
Contents 

 
 This section contains the following topics: 
 

Topic See Page 
Application Window 37
Toolbar 42
Menu Bar – Tools 44
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Subsection 3.1: Application Window 

 
Introduction This section describes eSubmitter’s Application Window and its different parts. 

 
The eSubmitter Application Window has two layouts that change the 
orientation of the text on the screen:  simple and expert.  When you first start 
up the application, eSubmitter opens in the simple layout with the screen view.   

 
Simple View The simple view shows only the current data entry screen and “hides” the outline 

tree.  The simple view separates the Submission Display Screen into three 
additional areas (as shown below): 
 

• Header Area (located at the top) 
• Outline Area or Screen Area (located in the middle) 
• Button Bar (located at the bottom), which allows forward and backward 

movement through the screens, as well as the ability to switch back and 
forth between the outline or screen view. 

 

 

Button Bar

Screen 
Area 

Header Area
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Subsection 3.1: Application Window 

 
Expert View The expert view allows the user to navigate through the form using an outline 

tree located on the left side of the screen.  The expert view separates the 
Submission Display Screen into four additional areas (as shown below). 
 

• Header Area (located at the top) 
• Outline Area (located at the left) 
• Screen Area (located to the right) 
• Splitter Bar (located between the outline and screen areas) 

 

 

Header 
Area 

Outline 
Area 

Splitter 
Bar 

Screen 
Area 
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Subsection 3.1: Application Window 

 
Layouts Both layouts provide the same information. It is your choice as to which layout 

works best for you.  You can switch between the two layouts very easily, as 
well as customize eSubmitter to open in the expert layout.  To learn how to 
change eSubmitter so that the application opens in the expert layout, rather than 
in the simple layout, see User Preference Tab – Layout.  
 
The Application Window, whether in simple or expert layout, is divided into 
three parts, as shown below. 
 

1. Menu Bar 
2. Tool Bar 
3. Primary Report Screen 

 

 

Menu 
Bar Tool Bar 

Primary 
Report 
Screen 

 
Parts of the 
Primary Work 
Area 

The different parts of the Primary Work Area are defined as follows: 
 
 

Continued on Next Page 
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Subsection 3.1: Application Window 

 
Header Area Displays the following general information about the open submission: 

• Submission Name – is the name that you created for the report.  
 

• Report Type – will always be CeSub Report. 
 
 

• Last Modified – represents the date and time the submission 
information was last saved to the disk file. The date and time are 
automatically updated after each save. 

 
• Packaged Date – represents the date and time the submission files were 

generated for transfer to CDRH. The date and time are automatically set 
after the files are packaged for submission to CDRH. 

 
Outline 
Area/View 

Displays tabs that organize the report into sections (as shown below). 
 

 
 
Each tab within the outline has an image to the left of its descriptive text. This 
image depicts which tab contains the section that is currently displayed within 
the screen area (i.e., the tab with the highlighted green image). 
 
Each section within the outline contains a folder image to the left of the section 
text. This folder image depicts the status of required information that is missing 
from within the question responses of the section. For example: 
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Subsection 3.1: Application Window 

 
• Green check mark indicates no required information is missing. 
• Blue question mark indicates at least one item of required information 

is missing. 
• No mark indicates that the section does not contain any required 

questions. 

 
Screen 
Area/View 

Displays the questions and responses associated with the selected section in the 
outline area. There is complete flexibility in maneuvering through the screen 
area. However, questions should be answered in order. Responses to some 
questions will determine whether further questions are required or even 
applicable, which means they may become disabled. 
 
Some questions within the screen area may be required in order for the report to 
be considered complete. These questions are designated with a blue dot to the 
right of the question text. A complete list of required information that is 
currently missing from the report can be accessed by selecting the Identify 
Missing Data option on the Output menu.  

 
Splitter Bar Is the vertical bar between the outline and screens areas in the Expert layout, as 

shown below. By dragging the bar with the mouse to the left or right you can 
control the proportion of the window that is allocated to each of the areas. 
Adjusting this bar may be necessary on smaller monitors in order to improve 
readability of the text.  
 

 

Splitter Bar 
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Subsection 3.2: Toolbar 

 
Introduction 

 
 
The tool bar is a row of buttons that are designed to provide quick access to specific 
or commonly used commands and options.  The tool bar is located below the menu 
bar.   
 
            Note: The screens and information that are accessed through the icons can 

also be accessed using the following menus: File, Edit, View, and Help. 
However, you must access information for Tools and Output (with the 
exception of Package Files for Submission) through the actual menus. For 
information relating to tools and output functions, refer to pages 44 and 96 
respectively. 

 
The buttons on the tool bar are grouped by functionality and are described below: 

 
Tool Function 

New – Displays the New Template Dialog box, which allows 
a new (empty) template to be created.   

Open – Displays the Open Template Dialog box, which 
allows an existing template to be selected and opened.   

Save – Saves any changes within the open template to 
permanent storage (e.g., to the disk).  

Simple Layout – Selects the simple layout, which displays 
the current data entry screen and contains basic options for 
moving forward and backward through the report one screen 
at a time. 

 

Expert Layout – Selects the expert layout, which contains 
the overall outline and current data entry screen side-by-side.   

Home – Takes you to the home screen. 
 

Continued on Next Page 
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Subsection 3.2: Toolbar 

 

Previous – Allows you to navigate to the previous screen. 
 

Next – Allows you to navigate to the next screen.  
 

Process Screen Changes – Processes your changes to screens 
without saving the template or selecting another node.  This 
option allows you to see how rules impact the form based on 
the changes made without having to leave the screen. 

 

Screen Undo 
 

Cut 
 

Copy 
 

Paste 
 

Package Files for Submission – Allows you to package your 
submission to send to CDRH after you have completely 
answered all questions, and no data is missing. For complete 
information, see Packaging Submission Files on page 85. 

 

Help Topics  
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Subsection 3.3: Menu Bar - Tools 

 
Introduction Each command on the Tools Menu is described 

below:  

 
Tool Function 

Establishment 
Address Book 

Displays the 
Establishment 
List Dialog box, 
which provides 
the ability to 
maintain the 
addresses of the 
pertinent 
manufacturing 
and corporate 
facilities 
associated with 
your reports.  

You only need to enter each company name and address once into 
the Establishment Address Book, then select the appropriate entry 
in response to each question. If the mailing address is the same as 
the physical address, the physical address can be copied into the 
mailing address fields. If they are similar but not exactly the same, 
it can be copied, and then edited. The Establishment Address Book 
will always be accessible for future reports, and you can update it as 
needed. This should reduce confusing, misspelled, and redundant 
entries.   

The Establishment List Dialog box contains a list of all the available 
establishments and a comments area for viewing the comments on 
the selected establishment. In addition, if you scroll across the 
establishment list, you’ll see fields containing basic identifier 
information about each establishment.   

The options (New, Edit, Delete, Close, and, Help) in this dialog 
box are described below: 

Continued on Next Page 
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Subsection 3.3: Menu Bar - Tools 

 

New Displays the New Establishment Dialog box, which allows a 
new establishment to be created.  Below is an example. Enter 
information in the fields to identify a particular establishment. 

 
 

⇒ Click the Physical Location tab to enter address 
information for where the establishment is 
physically located. See below. 

 
 

⇒ Click the Mailing Location tab to enter address 
information for the mailing address of the 
establishment. See below. 
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Subsection 3.3: Menu Bar - Tools 

 

 
 

⇒ Click  if the mailing location is 
the same as the physical location of the 
establishment. The information is automatically 
copied into the address fields (as shown above).  
However, if the mailing location differs drastically 
from the physical location, you must manually enter 
the information. 

⇒ When you are finished with the addresses, click 
 to save your edits. Click  to 

ignore all edits or  to see help text. You 
return to the Establishment List Dialog box.  

Displays the Edit Establishment Dialog box, which allows the 
selected establishment information to be changed.  (You enter 
information in this dialog box in the same manner as the New 
Establishment Dialog box.) 

Edit 

Delete Deletes the selected establishment from the list. 

Close Closes the dialog box. 

Help Displays the help window with text.  
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Subsection 3.3: Menu Bar - Tools 

 
Tool Function 

Contact 
Address Book 

Displays the 
Contact List Dialog 
box, which allows 
the names and 
addresses of the 
pertinent people 
associated with the 
report to be 
maintained.  You 
only need to enter 
each person's name 
and contact 
information once into the Contacts Address Book, and then you can 
select the appropriate individual in response to each question. 
Existing Establishment addresses can be selected (from the 
Establishment Address Book) for each contact. The Contact 
Address Book will be retained and accessible for future reports, and 
you can update it as needed. This should reduce confusing, 
misspelled, and redundant entries. 

The Contact List Dialog box contains a list of all the available 
contacts and a comments area for viewing the comments on the 
selected contact. In addition, if you scroll across the contact list, you 
will see fields containing basic identifier information about each 
contact.  
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The options provided in this dialog box are described below: 

 

New Displays the New Contact Dialog box, which allows a new 
contact to be created.  

Displays the Edit Contact Dialog box, which allows the 
selected contact information to be changed. 

Edit 

Delete Deletes the selected contact from the list. 

Close Closes the dialog box. 

Help Displays the help window with text.  

 



 

Subsection 3.3: Menu Bar - Tools 

 
Tool Function 

Submission 
File List 

Displays the 
Master File 
List Dialog 
box, which 
allows 
attached file 
information 
to be 
entered 
once for a 
submission 
but reused 
across 
questions in the report. For complete information on preparing a 
submission, see page 50.  File attachments must be in PDF. 
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Attaching PDF files requires software capable of viewing and/or 
printing PDF files (e.g., Adobe Acrobat). If you did not set your file 
viewer under User Preferences, the first time a PDF file is attached, 
the software will prompt you to locate the application within the 
system that will be used to view/print such files.  Once identified, the 
software will no longer prompt for this information. For information 
on setting up your PDF Viewer, see page 26.  

Note:   The file list is specific to the report that is currently open. 

The Master File List Dialog box manages the file attachment 
information related to the open report. The dialog box contains a list 
of all the attached files that are currently available, an area for general 
information on the selected file, and options for managing the list.  
The file list displays the following for each:  

• Descriptive title  
• Physical file name  
• Number of questions that currently reference the file as an 

attachment 
• File date  
• File size 
• Path to the file location 
 

The options provided in the dialog box are described below:  
 



 

Subsection 3.3: Menu Bar - Tools 

 

Displays the New File Dialog box, which allows a new file to 
be added to the list of attachments. 

Add 

Displays the Edit File Dialog box, which allows the selected 
file title and general description to be changed.  

Edit 

Delete Deletes the selected file from the list. 

View Displays the selected file within the specified PDF viewer. 

Close Closes the dialog box. 

Help Displays the help window with text.  

 
Tool Function 

Assign 
Report ID 

 

Allows you to enter an FDA-related identifier to a submission.  After 
you have sent the submission to the FDA for processing and have 
received an acknowledgement, you can record the unique identifier 
assigned by CDRH (such as an accession number). For complete 
information on preparing a submission, see page 50. 

To enter a Report ID: 

⇒ Select Assign Report ID from Tools on the Menu bar.  
You see the Assign Report ID dialog box, as shown 
below. 

⇒ Enter the unique identifier assigned by CDRH. 

⇒ If you are satisfied with your entry, click OK. Or, 
click Cancel to close the dialog box without making 
any changes. 
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Section 4: Preparing a Submission 
Contents 

 
 This section contains the following topics: 
 

Topic See Page 
Entering Submission Information 51
Saving Submission Entries or Changes 78
Completing a Submission 79
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Subsection 4.1: Entering Submission Information 

 
Introduction Entering information for a submission requires stepping through the report and 

answering questions.  If you use the simple layout, you progress through the 
report screen by screen, ensuring that you have filled in all appropriate 
responses.  If you use the expert layout, you progress through the report outline 
sections, activate each section to load the section questions and responses, and 
ensure that you have filled in all appropriate responses.   
 
Note: For the purpose of this guide, all graphics are in the expert view. Also, 
information marked with a blue dot is required.  
  
For additional information on the simple and expert layouts, see Interface on 
page 36. You should follow the order of the sections as they are listed in the 
outline. The order has been set up to represent the most logical progression 
through the report. 

 
Question Types The CeSub eSubmitter application uses several different types of questions to 

capture all the information that is required for a specific report. The response that 
you enter depends on the type of question used in your particular report.  For 
example, to answer a specific question, you may be required to select a response 
from a drop-down box, type in text, attach a separate PDF file, select a check box, 
or provide contact information. 
 
This section describes each of the different question types and includes examples 
of their respective responses.   
Note:  You may not see all of these types of questions in one particular 

report.  The purpose of this section is to provide a brief overview of all of 
the different question types that are used in the eSubmitter software. 
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Subsection 4.1: Entering Submission Information 

 

Address This question type requires that you enter the address and phone 
numbers of your establishment. You enter the information in text 
boxes and make selections using drop-down menus and clicking 
option buttons. An example is shown below. Other types of 
address questions are Contact and Establishment, which will be 
discussed below.  

 

 

Check 
Box 

This question type requires that you click on the box to select or 
clear the check mark to answer a question. See the example 
below. 

 

Continued on Next Page 
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Subsection 4.1: Entering Submission Information 

 

Contact 
(Simple) 

This question type requires that you type contact information 
(first name, last name, etc.) in text boxes. Entries may or may not 
be required.  The figure below shows an example of a simple 
contact question with the first name and last name as required 
entries (as indicated by the blue dots).   

Entries in a simple contact question are saved with a specific 
submission but will not be captured in the Establishment or 
Contact Address Book. For more information about 
Establishment Address Books, see page 44. 

 

Contact 
(Multi-
Part) 

This question types contains various areas that you need to 
complete (indicated by the tabs: Establishment Identification, 
Physical Location, and Mailing Location).  For this question type, 
you may enter contact information (first name, last name, etc.) 
directly into text boxes, or you may copy this information from 
the Contact Address Book.  When you enter the information 
directly (without using the Contact Address Book), the contact 
information is only saved for the submission.  Copying the 
information from the Contact Address Book saves time for data 
entry because the information is automatically copied into the 
question. Information in the Establishment and Contact Address 
Books requires that you only enter the data once and reuse it 
across multiple submissions.  

The figure below shows an example of a multi-part contact 
question. 
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Subsection 4.1: Entering Submission Information 

 

 

Tabs 

 
Copy 
Information 
from Contact 
Address Book 
into Contact 
Question 

To copy information from the Contact Address Book into the Contact Question, 
follow the instructions below.  

 

Action Graphic 

1. Click the Copy from Contact Book icon in the 
question. The Contact List Dialog box is displayed, as 
shown below. 

 

 
Contact List 
Dialog Box 

 
 

2. Click to highlight and select the desired contact.  

Continued on Next Page 
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Subsection 4.1: Entering Submission Information 

 

3. Click Select. The contact information is 
automatically populated in the different entry areas.  

 4. If the information is not exactly the same, you can 
edit the information after you have copied it. 

 5. To see the other information, click the desired tab. If 
you copied the contact information from the Contact 
Address Book, the information for these tabs will be 
completed as well. 
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6. For more information about Contact Address Books, 
see page 47. 

 

 

Drop-
Down 
Menu 

This question type requires that you select a response from a 
list of entries that appear after you click the box with the down 
arrow ( ).  Below is an example of a question with a drop-
down menu. 

 

 

Establish-
ment 

This question type contains various areas that you need to 
complete (indicated by the tabs: Physical Location and Mailing 
Location).  For this question type, you may enter contact 
information (establishment name, etc.) directly into text boxes, 
or you may copy this information from the Establishment 
Address Book.  When you enter the information directly 
(without using the Establishment Address Book), the 
establishment information is only saved for the submission.  
Copying the information from the Address Book saves time for 
data entry because the information is automatically copied into 
the question. Information in the Establishment and Contact 
Address Books requires that you only enter the data once and 
reuse it across multiple submissions.  

Below is an example of an establishment question. 



 

Subsection 4.1: Entering Submission Information 

 

 
 
Copy Information from 
Establishment Address 
Book into Establishment 
Question 

To copy information from the Establishment Address Book into the 
establishment question, follow the instructions below.  

 

Action Graphic 

1. Click the Copy Establishment icon in the question. 

 2. Click to highlight and select the desired contact. 

3. Click Select. The contact information is automatically 
populated in the different entry areas.  

 4. If the information is not exactly the same, you can edit 
the information after you have copied it. 

 5. To see the other information, click the desired tab. If 
you copied the contact information from the Contact 
Address Book, the information for these tabs will be 
completed as well. 
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6. For more information about Establishment Address 
Books, see page 44. 

 

 
 
 



 

Subsection 4.1: Entering Submission Information 

 

File 
Attachment 

This question type allows you to attach a PDF file as a 
response.  The question may contain a text editor that allows 
or requires you to type additional information.  In addition, 
this editor may be an HTML Editor, which allows you to 
format what you type (bold, underline), run spell check, or 
insert a table.  You may use this area to provide descriptive 
information or clarification, such as “see page 15 of the 
attached user manual.”  You may be required to enter the 
attachment or the descriptive text. 

Attaching PDF files requires software capable of viewing 
and/or printing PDF files (e.g., Adobe Acrobat). The first 
time a PDF file is attached, the software will prompt you to 
locate the application within the system that will be used to 
view/print such files.  (See below).  

 

Once identified, the software will no longer prompt for this 
information. For information on setting up your PDF Viewer, 
see page 26.  

Below is an example of an attachment question with a 
response entered. 

 

Note:  You may only attach files that are PDFs; no other 
formats (such as Microsoft Word or Excel) are 
acceptable. File names should not contain more 
than 250 characters.  Do not use symbols when 
naming the files for attachments. For example, do 
not use slashes (/) (\), tildes (~), asterisks (*), periods 
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(.), brackets [ ], single quotation marks (‘), double 
quotation marks (“) or parentheses ( ).  Once the file 
is attached to a question, it can be selected as an 
attachment to other questions, if appropriate. 

 
Attach PDF 
File to 
Attachment 
Question 

To attach a PDF file to an attachment question, follow the instructions below. 

 

Action Graphic 

1. Click the file folder icon to select the desired PDF 
file. A Select File dialog box is displayed (as shown 
below).  

 

 
Select File 
Dialog Box 

 
 

2. Click to select the desired file (if it is listed). 

OR 
 
Click the Add icon to place another file in the list. A 
New File Dialog box is displayed. 

 

 

Continued on Next Page 
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New File Dialog 
Box 

 
 

3. Click the file folder icon. You will see a Select File 
Dialog box.    

 
Select File 
Dialog Box 

 
 

4. Click in Look In to locate the drive, such as Local 
Disk (C:), or folder where the PDF is stored.  
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5. When you locate the desired PDF, click to select it 
(highlight). The name of the file appears in File Name 
(as shown below). 

 

Continued on Next Page 
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Select File 
Dialog Box 

 
 

6. Click Select. The Select File dialog box closes, and 
you return to New File Dialog box.  

7. Enter a title in Descriptive title (required entry) and a 
description in General description, if desired. 

 

8. Click OK.  You return to the Master File List Dialog 
box.  The PDF that you just added is automatically 
selected (highlighted). 

 
Master File List 
Dialog Box 

 
 

9. Click Select. You see the path (location) of the file on 
the network drive or hard drive of your computer 
appear in the file attachment question.  
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Multiple 
File 
Attachments 

This question type allows you to attach multiple PDF files as a 
response.  Below is an example of an attachment question with a 
file attachment included. 

 
Attach Multiple 
PDF Files to 
Attachment 
Question 

To attach multiple PDF files to an attachment question, follow the instructions 
below. 

 

Action Graphic 

1. Click the Add File icon. You see a Select File Dialog 
box.  

 
Select File 
Dialog Box 

 
 

2. Click to select the desired file (if it is listed). 
 
OR 
 
Click Add to place another file in the list. 

 

Continued on Next Page 
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3. Click Select. You see information about the file 
appear.   

 4. To see additional information, use the scroll bar. 

5. Click the Add File icon and repeat steps 2 and 3 to 
add another file attachment.  

6. Repeat step 5 for each file that you wish to add. 

 
OR 
 
Click the Delete File icon to remove a file from the 
attachment question. 
 
OR 
 
Click the View File icon to see a PDF file in the list of 
files. 

 

 

 

 

 

 

 

Guidance 
Documents 

This question type allows you to select the guidance 
documents that you used to prepare your submission, as well 
as provides space for you to add supporting text if necessary.  
Below is an example of a guidance document question. 

 
Select a 
Guidance 
Document 

To select a guidance document, follow the instructions below. 

Continued on Next Page 
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Action Graphic 

1. Click the Add Guidance icon. The Guidance 
Document Filter Dialog box is displayed (as shown 
below). 

 

 
Guidance 
Document 
Filter Dialog 
Box  

 
 

2. On this dialog box, you have several options for 
searching for a particular guidance document: 

• In the Title text box, you can type the title of 
the desired document (if you know what it is).  

• If you do not know the title of the document, 
select the applicable office from the Office list 
box. 

• On the Division list box, select the desired 
Division. 

• Click Clear Filter to delete your selections 
and begin a new search. 

 

 

 

 

 

 

 

Continued on Next Page 
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 3. Depending on which method you used, one or more 
guidance documents will appear in the Guidance 
Documents matching the specified filter criteria 
area of the screen 

 4. Use the scroll bar to see information about the found 
guidance documents.  

5. If you are connected to the Internet and have Adobe 
Acrobat installed, click to select a desired document, 
and click View Guidance to see the selection. 

6. To move a guidance document to Guidance 
Documents currently selected area of the screen:  

• Click to select (highlight) a particular guidance 
document. 

• Click Select. The selected document appears 
in Guidance Documents currently selected 
area of the screen. 

• Repeat the above two items for each desired 
guidance document.   

• Click Delete to remove a guidance document 
from your selection. 

 

 

 

 

 

 

7. Click OK when you have made your selections.  

You return to the guidance document question with 
your selection appearing. Below is an example of a 
guidance document question containing a response. 

Continued on Next Page 
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Guidance 
Document 
Containing a 
Response 

 

 

List Item This question type allows you to select an item from a 
list of options.  Below is an example of a list item 
question. 

 
 
Access the List 
of Available 
Options 

To access the list of available options, follow the instructions below. 

 

Action Graphic 

1. Click the Select Item icon. A Selection List Dialog 
box is displayed (as shown below).  

 
Selection List 
Dialog Box 
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Continued on Next Page 

2. Click to select (highlight) the desired option.  

3. Click the Select button. The Selection List Dialog box 
closes, and you return to the open submission with the 
list item question showing your selection (as shown 
below). 

 
 

 

4. If you wish to change your response, click the delete 
icon. Your response selection is deleted from the 
question.  
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5. Repeat steps 1 through 3 to make another selection.  

 

Memo 
(Multi Line 
Text) 

This question type provides an area for you to enter several 
lines of text (as shown below). 

The question may contain a Rich Text Editor which allows 
you to format what you type (bold, underline), run spell 
check, or insert a table.  The tool bar for the Rich Text Editor 
will appear after you click in the text area to begin typing.  
Below is an example of a multi-line question with a rich text 
editor.   



 

Subsection 4.1: Entering Submission Information 

 
 

Message This question type provides information to you as you 
complete a submission. You may see several different types 
of messages as you progress through your submission. 
Different examples of the message types are listed below: 

• Information Message 

• Error Message 

• Note Message 

• Confirmation Message 

 

• Warning Message 
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Product 
Code 
(Single) 

This question type allows you to search for and then identify 
the product code that is assigned to your product or device.  If 
applicable, you are able to search for the device class, device 
panel and particular CFR section.  The response to this 
question is for a single product code.  Below is an example of 
a product code question. 

 
Enter a Three-
Letter Code in 
the Product 
Code Question 

To enter a three-letter code in the product code question, follow the instructions 
below: 
 

• If you know the three-letter code assigned to your product/device, enter it 
in the text box. The remaining fields are automatically filled in for you. 

• If you wish to remove your entry, click the delete icon ( ). 
• If you do not know the three-letter code, see the instructions below to 

search for the code.  
• If you are selecting a product code for a radiation emitting product and do 

not see an appropriate code, enter RZZ. 

 
Search for a 
Three-Letter 
Code by 
Keyword 

To search for a three-letter code by keyword, follow the instructions below: 

 

Action Graphic 

1. Click the Select Item icon. A Product Code Filter 
Dialog box is displayed.  

Continued on Next Page 
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Product Code 
Filter Dialog 
Box  

 
 

2. Enter a keyword to search the database.  You will be 
provided a list of product codes from which to choose 
in the Matching Product Codes portion of the dialog 
box. 

 

3. To further refine your search, if desired:  

• Click the Device Class drop-down list and 
make a selection. 

• Click the Classification Panel drop-down list 
and make a selection. 

• Click the Select Item icon ( ) next to 
the Identifier (under C.F.R. Selection) and 
make a selection. 

• Click  to remove entries and 
start the search over again. 

 

 

 

 

 

Continued on Next Page 
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4. Click to highlight the best match to your 

product/device, and click . You return 
to the submission screen and the product code 
question. The remaining fields in the product code 
question are filled in for you (as shown below). 

 

 
 

 

Product 
Codes 
(Multiple) 

This question type allows you to identify other product codes 
applicable to the submission. Below is an example of a multiple 
product code question. 

 
Add Product 
Codes 

To add product codes, follow the instructions below: 

 

Action Graphic 

1. Click the Add Product Code icon. You see the 
Product Codes Filter Dialog box (as shown below).   

Continued on Next Page 
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Product Code 
Filter Dialog 
Box 

 
 

2. Enter Product Code and Product Code Name in the 
appropriate sections.  

 

3. Click OK.  

 
Enter Multiple 
Three-Letter 
Codes in the 
Product Code 
Question 

To enter multiple three-letter codes in the product code question, follow the 
instructions below: 

 

Action Graphic 

 1. If you know the three-letter code assigned to your 
product/device, enter it in the Product Code text box. 
You see the product code/device appear in Product 
Codes matching the specified filter criteria (as 
shown below). 

Continued on Next Page 
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2. Click Select. The product/device appears in Product 
Codes currently selected (as shown below). 

 
 

 
 

3. Repeat steps 1 and 2 to continue to add product codes. 

OR 

• If you do not know the three-letter code, see 
the instructions below to search for the code.  

OR 

• Click OK to return to the multiple product 
codes question. 

 

 

 

 

 

Search for 
Multiple Three-
Letter Codes by 
Keyword 

To search for multiple three-letter codes by keyword, follow the instructions 
below: 

 

Action Graphic 

1. Enter a keyword in Product Code Name to search the 
database.  You will be provided a list of product codes 
from which to choose in the in Product Codes 
matching the specified filter criteria portion of the 
dialog box. 

 

Continued on Next Page 
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 2. To further refine your search, if desired: 

• Click the Device Class drop-down list and 
make a selection. 

• Click the Classification Panel drop-down list 
and make a selection. 

• Click the Select Item icon ( ) next to 
the Identifier (under C.F.R. Selection) and 
make a selection. 

• Click  to remove entries and 
start the search over again. 

3. Click to highlight the best match to your 
product/device, and click Select. The product/device 
appears in Product Codes currently selected. 

4. Repeat steps 1 and 2 to continue to add product codes.  

OR 

Click Delete to remove a product code from the 
selection. 

 

 

5. Click OK to return to the multiple product codes 
question, which shows your selections. 

 

Standards This question type allows you to select a standard for 
your submission from the CDRH list of recognized 
standards. Below is an example of a standards question. 

Continued on Next Page 
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Add a Standard To add a standard, follow the instructions below: 
 

Action Graphic 

1. Click the Add Standards icon. You see the Standards 
Filter Dialog box (as shown below).  

 
Standard Filter 
Dialog Box 

 
 

2. Enter a title in Title Reference (if known) to search 
the database.  
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3. To further refine your search, if desired: 

• Click the Category drop-down list and make 
a selection. 

• Click the Organization drop-down list and 
make a selection. 

• Click  to remove entries and 
start the search over again. 

 

Continued on Next Page 
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4. Click to highlight the best match to your 
product/device, and click Select. The standard appears 
in Standards matching the specified filter criteria. 

5. When you are finished adding standards, click OK. 
You return to the standards question. 

 

Table This question type allows you to select from a list or add text items 
that are then placed in a table. Below is an example. To make 

selections, click the Add icon ( ). 

 

Text, 
Single 
Line 

This question type allows you to type in text as a response.  Below 
shows an example of a text question. 
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Sections 
as 
Tables  

Entire sections may appear as a table.  This format is indicated by a 
row of buttons for New, Delete, Delete All, an up arrow, and a down 
arrow.  Directly below this row of buttons is the actual table (as 
shown below). 

You also see a List and Details tabs.  Click the New button to add an 
item to the table.  You see a screen containing questions for you to 
answer. An example is shown below. 

 

To see the items in the table, click Details.  If you accidentally enter a 
blank into the table, (by clicking New, not responding to any 
questions, and then clicking Details), you will see a line of colored 
blank spaces. Select the line of colored spaces and click the Delete 
button to remove the item from the table. 
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Entering 
Responses into 
the Submission 

To enter responses into the submission, follow the instructions below. 

 

Action Graphic 

1. The CeSub eSubmitter application must be open on 
your computer desktop, and a submission must be 
open. If the application and a submission are not 
open, see the instructions beginning on page 12. 

 

2. Navigate through the submission as follows: 

• If you are in the simple layout, use the buttons 
on the button bar to advance to next/return to 
previous screen. 

• If you are in the expert layout, use the outline 
section, and activate each section to load the 
questions. 

 

3. Provide a response to the question(s) on the screen. 
The response required depends on the type of 
question.   

 

4. Save your responses periodically.   

 
 



 

Subsection 4.2: Saving Submission Entries or Changes 

 
Introduction While moving through the submission, any changes made to question responses 

are automatically updated within memory (e.g., the user made a change to a 
question response, went to another section of the submission, and returned to 
see that the changes to the response were still in effect). If you have auto-save 
turned off in Preferences, these changes are only saved permanently when you 
select the Save option from the tool bar or File menu. Therefore, follow the 
same guidance that you would use when saving data in other software.  In other 
words, whenever you have entered an amount of data that would be frustrating 
to have to re-enter, select the save option.  For information on changing auto-
save preferences, see page 21. 
 
Note:  The software will remind you to save if data has been changed and you 

are about to perform an operation that would result in losing your 
changes, such as opening another submission or exiting the application.  

 
To save a submission: 

 

Action Graphic 

1. Click File > Save. 

OR 

Click   on the tool bar. 

If you do not finish entering information into a 
submission in one session, you may return to it at 
another time.  See Reopening an Existing 
Submission on page 35. 

 

2. If you wish to close the submission, click File > 
Close. The General Screen is displayed. 
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Introduction To complete a submission, you must identify if any data is missing from your 

report (and then enter the required data), package the files for submission, find 
the necessary files on your computer, and copy the files onto a CD.  

 
Missing Data You will only be able to package files for submission as long as no required 

data is missing from the submission.  To determine if any data is missing, you 
will generate a Missing Data Report.  To proceed, the desired submission 
should be open and displayed on your computer screen.   
Note:  All report outputs are generated as HTML and require an application 

capable of viewing HTML output, such as a WEB browser, the full 
version of Adobe Acrobat (not Acrobat Reader), or Microsoft Word. 

 
To determine if required data is missing from the submission: 

 

Action Graphic 

1. From the menu bar, click Output > Missing Data 
Report. The Report Output Dialog box is displayed 
(as shown below). 

 

 
Report Output 
Dialog Box 

 

Continued on Next Page 
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2. On this dialog box: 

• Select the desired application to view the 
output in HTML: 

• Click the option button: Default Browser or 
Other HTML Viewer (The default setting is 
your Web Browser.) 

⇒ If you selected Other HTML 
Viewer, the Select button becomes 
enabled. Click the Select button. 
You see the Select HTML Viewer 
Application File dialog box (as 
shown below).  

 

 

 

 

 

 
Select HTML 
Viewer 
Application File 
Dialog Box 

 

Continued on Next Page 
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3. • Click in the Look In box to navigate to the 
executable (.EXE) of the application to view 
the HTML.  For example, if you want to view 
the missing data output report in Word 2002, 
you would navigate using the following path: 

C: > Programs > Microsoft Office > Microsoft 
Office > Office 10> WINWORD.EXE 

The following screens display an example for the 
navigation sequence to find Word 2002’s executable 
(winword.exe): 

 

 
 

 
Finding Word’s Executable File (Navigation 1) 

 

 
Finding Word’s Executable File (Navigation 2) 



 

Subsection 4.3: Completing a Submission 

 

 
Finding Word’s Executable File (Navigation 3) 
 

 
Finding Word’s Executable File (Navigation 4) 

 

4. Click Select. You return to the Report Output Dialog 
box with your selection showing (as shown below). 

Continued on Next Page 

CeSub eSubmitter 
Release 4.3 User Guide  

82 



 

Subsection 4.3: Completing a Submission 

 
Report Output 
Dialog Box  

 
 

5. Select the desired shading of the report: lick the option 
button for Grayscale or Color. 

 

 6. Select the desired font size: lick the option button for 
Small Font or Large Font (which is approximately 
10 pt). 

7. When you are finished making selections, click OK. 
The eSubmitter software generates the report in 
HTML, which opens for viewing in the application 
that you selected.  The missing data output report will 
either state that there is no data missing or identify the 
missing data that must be entered (as shown below) 
before the files are packaged for submission. 

Continued on Next Page 
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8. After you have verified that no data is missing from 
the submission, you are ready to package your files 
for submission.  
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Submission Files) 

 
Packaging 
Submission 
Files 

After completing the submission and verifying that there is no information 
missing, you are ready to package the files for submission. To proceed, the 
eSubmitter application should be open, and the finished submission displayed 
on your computer screen. 

 
Package Files 
for Submission 

To package files for submission, follow the instructions below.  

 

Action Graphic 

1. Click Output > Package Files for Submission 
from the menu bar.  

 

2. If data is missing, see the warning (as shown 
below). 

 

 
Warning 

 
 

3. If the submission has all required data, the Packaging 
Files Dialog box is displayed (as shown below). 
Within the Packaging Files Dialog box you will be 
prompted to move through a series of steps detailed 
below. 

 

Continued on Next Page 
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Packaging Files 
Dialog Box  

 

 
Step 1: 
Overview and 
Package File 
Information 

This section contains a brief overview of the packaging process. Follow the 
instructions below. 

 

Action Graphic 

 1. Specify the submission package file name. 

 The Package File Name (.zip) text 
box identifies the default zip file 
name for the submission. 
(eSubmitter automatically uses the 
submission name for the zip file.)  
Make a note of the name for the 
zip file.   

Continued on Next Page 
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2. Specify the submission output location. 

i. The Package Output Location identifies the 
file folder where the zip file is located.  Make 
a note of the output location.   

ii. To change the location click the file folder 
icon (as shown below), locate the desired 
location, and click Select. 

 

 

 

 

 

 

 
 
 

 
 

3. Click Next to proceed to Step 2: File Attachment 
Verification.  

Continued on Next Page 
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Step 2: File 
Attachment 
Verification 

 
 
This section lists all file attachments used in the submission. 

 

Action Graphic 

 1. Check the list to ensure that all of the appropriate 
file attachments are listed (only files referenced in 
responses will be included).  See above for an 
example. 

CeSub eSubmitter 
Release 4.3 User Guide  

88 

2. Check the question counts to confirm that the files 
are attached.  

 NOTE: If a file appears to be missing from 
the list, go to the Submission File List 
within eSubmitter (File Menu > Tools > 
Submission File List).  In the Master File 
List, ensure that each file is attached to a 
question.  A zero in the Question Count 
column indicates that the file is not attached 
to a specific question and therefore will not 
be included in the packaged submission.   

 

Continued on Next Page 
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Submission Files) 

 

 3. Check the file dates, size, and locations to ensure 
the correct versions of the files are provided. 

4. Click Next to proceed to Step 3 and continue 
packaging the submission. 

OR 

Click Previous to go back to Step 1. 

                  OR 

Cancel and exit the Package File Dialog box. 

 

 

 

 

 

 
Step 3: 
Transmission 
Approach, 
Submittal 
Letter, and 
Packaging 

This section will differ based on the report you are filing.  If a specific step 
listed below does not appear in the dialog box on your screen, this is because it 
does not apply.  Please skip the instructions and move to the next step displayed 
on the Packaging Files Dialog box.  Below is an example of what may appear 
in Step 3. 
 

 

Continued on Next Page 
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Select 
Transition 
Approach (May 
or may not be 
available) 

Choose the selected approach to send your submission to CDRH.   
 

 The first approach is the traditional CD and signed cover letter 
mailed to CDRH.  See below for an example.  
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 The second approach is only to be used when sending your 

submission through the FDA Electronic Submission Gateway 
(ESG).   

 
NOTE: If you plan to send your submission through the ESG, 
you will need to register to use the ESG and set up an account.  
Please see http://www.fda.gov/esg/ for more information 
regarding the ESG. 
 
In addition, if the Attach Signed Submittal Letter is 
available, you must have the capability to scan your signed 
cover letter in the subsequent Output Submittal Letter step 
(see below). 

 

 

 
Output Submittal 
Letter (May or 
may not be 
available) 

Follow the instructions below for the Output Submittal Letter. 

Continued on Next Page 
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Submission Files) 

 

Action Graphic 

 1. 
Click the  button, as 
shown below.   

 
 

 
 

2. a. Ensure that your submittal letter is 
accurate.   

b. Print and sign the submittal letter. 

c. Prepare to mail the submittal letter 
(for CD transmission approach)  

OR 

d. Scan the submittal letter (for 
Gateway transmission approach) 
and note the location where you 
store the file (you will need to 
navigate to this location in the next 
step). 

 

3. Click on the folder icon (see below) to attach the 
signed submittal letter that has been scanned.    

 
 

 

Continued on Next Page 
 

CeSub eSubmitter 
Release 4.3 User Guide  

91



 

Subsection 4.3.1: Completing a Submission (Packaging 
Submission Files) 

 

4. Once you have located the signed cover letter, click 
Select to attach the file to the packaging dialog box.  
The signed cover letter path should appear (as 
shown below). 

 

 
 

 

 
Produce 
Submission 
Package 
(Always 
available) 

To produce a submission package, follow the instructions below.  

 

Action Graphic 

 1. 
Click on  to initiate the 
packaging of the ZIP file (as shown below). 

 
 

 
 

2. NOTE:  Once the submission has packaged 
successfully, the status bar will indicate that the 
packaging is complete (as shown below).  

 

 
 
 

 

Continued on Next Page 
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Submission Files) 

 

3. Click Next to proceed to Step 4 to view the 
transmission instructions related to your 
submission. 

 

 
Step 4: Transmit 
Submission Package 
(Always available) 

This section provides confirmation that the submission files have been 
successfully packaged. The submission is ready to be sent to CDRH. 
Follow the instructions below.  

 

Action Graphic 

 1. Read the instructions provided.  These instructions 
may vary depending on the approach selected in 
Step 3 (if the option was available).  See below. 

 
Transmit 
Submission 
Package 

 

Continued on Next Page 
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Subsection 4.3.1: Completing a Submission (Packaging 
Submission Files) 

 

2. Click Done to close the Packaging Files Dialog 
box 

OR 

Click Previous to return to Step 3. 

 

 

 

 
Printing, 
Locating, and 
Copying Files 

The following instructions do not apply if you are transmitting your submission 
via the Electronic Submissions Gateway.  Please see http://www.fda.gov/esg/ 
for Gateway transmission instructions.  If you are transmitting your electronic 
submission on CD, follow the instructions below: 
 
After packaging the files for submission, locate the packaged ZIP file on your 
computer and copy it onto a CD.  In addition, you will need to mail the signed 
submittal letter (printed in Step 3 of the eSubmitter Packaging Submission 
Files Process).  NOTE: For an OIVD submission, the truth and accuracy 
statement is part of the letter. 

 
Locate the 
Submission 
Files on the 
Computer’s 
Hard Drive 

To locate submission files on the computer’s hard drive, follow the instructions 
below.  

 

Action Graphic 

 1. Use Windows Explorer to navigate to the label for the 
computer’s installed hard drive, e.g., Local Disk 
(C:).  For example, on a computer with Windows 
2000: 

• Open Windows Explorer. 

• Double-click My Computer to display its 
contents. 

• Look for the label of the computer’s 
installed hard drive.  For example, (C:). 
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Subsection 4.3.1: Completing a Submission (Packaging 
Submission Files) 
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2. Double-click on the label for the hard drive to display 
its contents. 

 

3. Navigate to and double-click on the Program Files 
file folder to open. 

 

4. Navigate to and double-click on the eSub file folder 
to open. 

 

5. Double-click on the output file folder to open. The 
zip file that you created in Packaging Submission 
Files appears. Do not modify the zip file after it is 
generated by eSubmitter. 

 

6. Copy this file onto a CD.  

7. Mail the CD and signed cover letter to the address 
provided in your submission. 

 

 



 

Subsection 5: Menu Bar - Output 

 
Introduction The Output menu includes commands 

related to the output of reports for 
submission information.  For complete 
information on getting a submission ready 
to send to CDRH, see Completing a 
Submission on page 79.   
 
Note:   All report outputs are generated as 
HTML and require an application capable of viewing output, such as a WEB 
browser, the full version of Adobe Acrobat (not Acrobat Reader), or Microsoft 
Word.  
 
Each command on the Output menu is described below: 

 

Tool Function 

Missing 
Data 
Report 

Provides a list of required questions that you have not yet 
answered. The list is provided in HTML format.  You can save 
the report file at any time. However, you will not be able to 
create a submission file to submit to CDRH until there is no 
missing data. For complete information, see Completing a 
Submission on page 79. 

Blank 
Report 
Form 

Views/prints a blank submission form in HTML. 

 

Submission 
Report 

Views/prints out the submission report with your entries in 
HTML. 

Submittal 
Letter 

Provides a formatted cover letter in HTML for you to sign that 
identifies your file and must be submitted along with the CD 
and any hardcopy of the report (if required) to CDRH. 
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Section 6: User Support 

 
Introduction For technical assistance for the CeSub eSubmitter software, an email 

can be sent to cdrhesub@cdrh.fda.gov.  In the email, please be sure 
provide the company name and contact information where a response 
can be sent. 
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Section 7: Frequently Asked Questions 

 
Question: As CeSub eSubmitter requires Windows OS, Adobe Reader 5.0 (or full 
Adobe Acrobat), and a CD-R, does it require any special permissions for a user on a 
Win2K/WinXP machine? What exactly does jinstall.exe unpack? 
Answer: The CeSub eSubmitter application is based on Java. The installation program 
will unpack the application into the user designated location. All files installed will reside 
in the aforementioned designated location. The files installed include the application and 
support files, a Java runtime engine (JRE 1.4.2), and install/uninstall information. The 
JRE installed is specific to this application and should not interfere with other possible 
JRE’s installed (i.e., JRE is not recognized by the OS but instead called by the eSubmitter 
application directly). The install program will setup menu short-cuts as well as provide 
uninstall information to the OS, which will require access to the Windows registry. 
Otherwise, no additional permissions should be required. 
Question: Does eSubmitter introduce any new DLLs?  
Answer: No. 
 
Question: Does Submitter require any specific version of DLLs that are standard on 
the machine?  
Answer: No. 
 
Question: Does eSubmitter communicate outside the local box? Does it use any TCP 
ports?  
Answer: Yes. The application uses an internet connection to perform auto-updates of the 
application and support files (e.g., enhancements, fixes). The auto-update process is 
called at start-up every time the application is executed. However, if no internet 
connection is available the application will still execute correctly but no updates will be 
received. If you use a proxy server there are settings within a configuration of the 
application to give the application permission to contact its auto-update site. 
 
Question: Does eSubmitter introduce any vulnerabilities that you (the developers) 
are aware of?  
Answer: None that we are aware of. 
 
Question: Are there any issues I should be aware of that might affect our 
environment? 
Answer:  None that we are aware of. 

Continued on Next Page 
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Section 7: Frequently Asked Questions 
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Question: Can I install the software on a network?  
Answer: Yes. The software can be installed anywhere and will work properly.  A new file 
locking option has recently been added to the software to prevent users from accidentally 
overwriting the work of another.  For details, see Networking in Preferences on page 
Error! Bookmark not defined.. 
 
Question: I have a PDF that I want to include. Can I add it the WinZip file 
generated by eSubmitter? 
Answer: No.  Do not modify the file after it is generated by eSubmitter.  If you do modify 
a file, your submission will fail our loading process. You will have to repackage your 
files and resubmit the submission to CDRH.  Always attach the desired PDF to the 
appropriate question.  
Question: I sent my submission to CDRH, but was notified by a CeSub team 
member that something was wrong with my submission. I fixed the problem, 
repackaged the submission, and created a new CD. Is that all I have to do? 
Answer: No.  Be sure to print out a new submittal letter, sign this new letter and include 
with your resubmittal. 
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